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IMPORTANT!

Read this guide if you are
upgrading from a previous
version of QuickBooks.
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QuickBooks

Welcome!

QuickBooks 2008 contains many new features
and changes from previous versions. This guide
contains important information to get you working
with your company file as quickly as possible.

The guide is organized into three sections:

« The Installation section tells you how to install
the new version of QuickBooks and upgrade your
company data.

+ The Important information section has notes
about how QuickBooks 2008 handles features from
previous versions. We highly recommend that you
read this section - there are lots of changes, and you
may need to perform some actions before and after
QuickBooks 2008 upgrades your company file.

In Getting around QuickBooks, we show you what to
look forward to when using QuickBooks 2008.
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Installing the new version

During installation, most users can use the Standard Installation. However, if
you work in a multi-user environment (that is, more than one user can access
your company data at the same time from different computers), see the
Multi-user host or server installation section.

If you need further installation assistance, you can access the QuickBooks
support website at quickbooks.ca/support, or contact Product Support at
1 877 772-9158 (Monday to Friday, 8:00 a.m. - 8:00 p.m., EST).

ﬂ What should | do with my old version of QuickBooks?

Do not uninstall your old version of QuickBooks! You may need

it to run reports on your old company file. You may also need it

if you have company files that use the Multicurrency feature; for
details, see Multicurrency in the Important information section.

We recommend that you let the installation program choose where to
install QuickBooks 2008. You can choose a different location if you want;
QuickBooks will ensure that you do not overwrite your previous version.

Standard installation Standard (single user)

1 Insert the QuickBooks CD in your gRtion
computer's CD-ROM drive.

NOTE If the installation program does @ STANDARD
not start automatically, click Start in the : STALLATION
taskbar and then click Run._ Click Browse : One QuickBooks user,
and locate your CD-ROM drive. Double- : no network
click your CD-ROM drive, then double- :

click SETUP or SETUPEXE.

2 In the Welcome to QuickBooks Installation
window, click Expert Install.

3 In the Installation Options window, click
Standard and then click Install Now.

4 Follow the on-screen instructions.

The installation program will prevent you
from overwriting a previous version of
QuickBooks - you may need it later.
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5 To start QuickBooks, double-click
the QuickBooks icon on the desktop,
or click the Windows Start button
and then click QuickBooks from the
Programs group.

Multi-user host or
server installation

1 Make sure your computers are
properly networked. Refer to your
operating system’s documentation
for more information.

2 On the computer that acts as the host
or server for your QuickBooks company
file, insert the QuickBooks CD in the
CD-ROM drive.

NOTE If the installation program does
not start automatically, click Start in
the taskbar and then click Run. Click
Browse and locate your CD-ROM drive.
Double-click your CD-ROM drive, then
double-click SETUP or SETUPEXE.

3 In the Welcome to QuickBooks
installation window, click
Expert Install.

4 In the Installation Options window,
click Multi-user Host or Server and
then click Install Now.

If you're not sure which one you should
choose, see the installation type
diagrams at the side.

5 Follow the on-screen instructions.

The installation program will prevent
you from overwriting a previous version
of QuickBooks — you may need it later.

6 On each additional computer that will
access QuickBooks from the network,
follow the instructions for a Standard
installation.

Multi-user options

Company
file
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INSTALLATION INSTALLATION

One QuickBooks user, using
network hosting (home office)

Company
file
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— INSTALLATION

@ STANDARD @
INSTALLATION
Multiple QuickBooks users,

using network hosting

Company
file

SERVER
INSTALLATION

;\
@ STANDARD
INSTALLATION

Multiple QuickBooks users, using a
dedicated server on a network




Upgrading your files

What company files can be upgraded?

You can upgrade company files from all earlier versions of QuickBooks. If your
file is from QuickBooks 2003 or earlier, visit quickbooks.ca/conversionkit
for information on upgrading it to QuickBooks 2008.

Your company file must not have any transactions that use the
Multicurrency feature. Company files with multicurrency transactions
cannot be upgraded to this edition of QuickBooks 2008. For details, see
Multicurrency in the Important information section.

Before you upgrade your company file

In your previous version of QuickBooks, print trial balance reports for

each of these dates:

* Today

* The end date of the last sales tax period for which you sent a GST/HST/
QST return (if any)

» The end date of the last sales tax period for which you sent a PST return (if any)

Verify your company file: In your previous version of QuickBooks, go to the
File menu, click Utilities, then click Verify Data.

Find your last sales tax return(s): Locate the paper copy of the last GST/
HST/QST and PST sales tax returns that you filed and have them with you
when you start the upgrade process. You will need information from these
returns to upgrade your company data.

Make a backup of your old company files: QuickBooks prevents you from
overwriting your original company file during the upgrade process. However,
for added safety, make a backup before you start.

Starting the upgrade process
1 In QuickBooks 2008, open your old company file.
2 When prompted to upgrade your file, enter YES and click OK.
3 Follow the on-screen instructions.
» When prompted to back up your data, click OK.
» When asked, enter the end dates of the periods for the last GST/HST
and PST or QST sales tax returns that you sent to the government, if any.
» When asked where you want to save your new company file, we
recommend that you allow QuickBooks to choose the location. This puts
your company file in a standard location for newer operating systems.
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4 When the conversion is complete, QuickBooks creates a report about
what happened during the conversion. Read this information and take
any actions that are necessary.

To see the report, go to the Help menu and choose Learning Centre,
click Key Upgrader Tasks, then click the link next to Results of your
company file conversion.
TIP The Key Upgrader Tasks tab in the Learning Centre contains
more information that you may find useful.
5 If you file sales tax (GST, HST, PST, or QST), there are some additional
steps you must perform. It is VERY IMPORTANT that you perform these

steps! If you do not, the amounts on your next sales tax return will be
incorrect. For details, see Sales Tax in the Important information section.

What should | do with my old company file?

Do not delete your original company file! You need it to create sales tax
reports for transactions that took place before you upgraded your company
file, as well as for audit or tax inspection purposes.

During the upgrade process, QuickBooks knows the location of your old
company file and will prevent you from overwriting it.

Sales tax (GST, HST, PST, QST)

The way sales tax is managed in QuickBooks 2008 has been improved from
earlier versions. Most of these changes occur behind the scenes, so you
won't have to change the way you work. However, there are some important
differences that you need to know about.

Follow these very important additional steps before and after
you upgrade your company file. If you do not, the amounts on
your next sales tax return will be incorrect!

Before you upgrade your company file

1 Locate your paper copy of the last federal (GST/HST or GST/HST/QST)
sales tax return you sent to the government. If you also file a provincial
sales tax return, locate your paper copy of that as well. Have these with
you when you start the upgrade process. You will be asked for dates on
these returns during the upgrade process.




2 In your previous version of QuickBooks, print trial balance reports for
today, the end date of the last sales tax period for which you sent a
GST/HST or GST/HST/QST return, and the end date of the last sales
tax period for which you sent a PST return (if any).

3 If you haven't already done so, in your previous version of QuickBooks,
update the sales tax rate for your GST sales tax codes. For more details,
g0 to the How do | update my company file to use the new GST
rate for January 1, 2008? FAQ on the QuickBooks knowledgebase
(quickbooks.ca/support).

After you upgrade your company file

1 Create a trial balance for today and compare it to the trial balance
for today from the previous version of QuickBooks. They should be the
same.

2 Create a Tax Agency Report for the current sales tax period and check
whether you have an uncategorized tax amount. (You likely will.)

This can be caused by:

« manually filed or unfiled transactions in past sales tax periods. In
previous versions of QuickBooks, if transactions were manually filed or
unfiled, it was possible for sales tax reports to show a slightly different
balance owing than the actual amount due in your sales tax liability
account. In the upgrade process, these small discrepancies are
brought forward to the current period as an uncategorized amount.

a balance owing or refund due carried forward from a previous
sales tax period. If you have not yet paid the amount due from your
last sales tax period or did not pay the full amount, the amount

still owing will be carried forward to the current period as an
uncategorized amount.

transactions entered incorrectly in the current sales tax period.
If you have recently entered a transaction in a non-standard way,
such as recording a sale with a sales tax amount directly in the
Make Deposits window instead of using a sales receipt, the sales
tax amount from the transaction appears in the report as
uncategorized.

3 If you have uncategorized tax amounts, do this:

« If the amount is positive, you owe it to the government. Make a sales
tax adjustment to assign the amount to the “GST on sales” sales tax
item of your GST/HST return, the “QST on sales” item of your QST
return, or the “PST on sales” item of your PST return. The amount
owing will be paid when you file for the current sales tax period. For
details, search the in-product help for “How do | handle uncategorized
sales tax amounts”.




« If the amount is negative, the government owes it to you. Make a
sales tax adjustment to assign the amount to the “GST on purchases”
sales tax item of your GST/HST return, the “QST on purchases” item
of your QST return, or the “PST on sales” item of your PST return (for
PST, also select “Decrease Sales Tax Line”). The amount will reduce the
tax you owe when you file a return for the current sales tax period. For
details, search the in-product help for “How do | handle uncategorized
sales tax amounts”.

If the amount of uncategorized tax is very large, we highly recommend
that you talk to an accountant.

4 If you have memorized transactions with items that use sales tax, do the
following with each memorized transaction:

» Open the memorized transaction. You can access them from the
Memorized Transaction List (go to the Lists menu and click
Memorized Transaction List, then double-click the desired
memorized transaction).

« In the body of the transaction, for each item that uses sales tax, select
a different sales tax code than the one currently selected. Remember

the original sales tax code!
Continued...




 Re-select the original sales tax code for the transaction.

» Go to the Edit menu and click Memorize (transaction type). You will be
asked if you want to replace the existing memorized transaction; click
Replace.

This tells QuickBooks to update the Memorized Transaction List with the
new sales tax functionality. If you do not update a memorized transaction
as described, QuickBooks will assume that the sales tax for that
memorized transaction is 0.0%.

5 If you are a Québec customer, there are additional steps you need to

take before you file your next GST/HST/QST return. For details, go to the

knowledge base at knowledgebase.quickbooks.ca and search for the

article titled “How do | upgrade a company file if | track Québec sales tax?”

« The way QuickBooks handles GST and QST in Québec has been
significantly improved and now includes support for the consolidated
GST/HST/QST return. Moving from the former two-return system to the
new system requires some additional steps.

Sales tax reports for previous sales tax periods

Due to changes in how sales tax is tracked, reports are not available for sales
tax periods that were completed in your previous version of QuickBooks.

If you want to view sales tax reports for past sales tax periods, open your
original company file in your previous version of QuickBooks.

Piggyback sales taxes

“Piggyback” sales taxes are sales taxes that are applied to the base cost of an
item or service plus the GST. Piggyback taxes are typically used only in Québec
and Prince Edward Island.

When QuickBooks upgrades your company file, it looks at your company’s

home province as specified in the Company Information window. If you have

custom sales tax codes that have the “piggyback” checkbox set incorrectly for

your province, QuickBooks does this:

« If the company is in Québec or PEI, all custom sales tax codes are changed
to piggyback taxes.

« If the company is not in Québec or PEI, all custom sales tax codes are
changed to non-piggyback taxes.

« In both cases, the percentage rate of the tax code is adjusted so that the
effective tax rate is the same. Assuming that your previous tax rate was
correct (that is, that your old tax rate took piggyback taxes into account),
you can use the same sales tax codes as before.




Tax Agencies

In QuickBooks 2008, tax agencies (such as the Canada Revenue Agency)
are treated as vendors and specific information about taxes paid to them
is stored in their vendor records. When you edit a tax agency vendor, you
can find the sales tax information on a new tab called Tax Agency Info. For
example, this tab is where you specify your sales tax reporting period.

QuickBooks creates different sales tax agencies depending on your province
or the province your business is located in. For example, “Receiver General”
is the federal sales tax agency you use when paying and filing GST/HST

outside of Québec.

Unit of Measure

The Unit of Measure feature has been
improved from previous versions:

* QuickBooks 2008 no longer has
a separate measure for “stocking”
items (that is, storing items on hand
for later sale). Instead, it uses the
smallest base unit that can be used
for purchases or sales.

Unit of Measure is now available
only in QuickBooks Premier. It is not
available in QuickBooks Pro.

Sales Orders

Sales Orders are now available only

in QuickBooks Premier. If you have
QuickBooks Pro, you can work with
existing sales orders, but cannot create
new ones.

Inventory Assembly items

Inventory Assembly items are now
available only in QuickBooks Premier. If
you have QuickBooks Pro, you can work
with existing assembly items, but cannot
edit them or create new ones.

TIP To upgrade to QuickBooks
Premier for Unit of Measure,
Sales Orders, and Inventory
Assembly Items functionality,
please contact QuickBooks
Sales at 1 888 333-8580 or
quickbooks.ca

For more details, search the
in-product help.
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4™ Multicurrency

The Multicurrency feature is not supported in this version of

@Y’ QuickBooks. If a company file has transactions in it that use
the multicurrency feature, this version of QuickBooks will not be
able to upgrade it. You can instead upgrade to the QuickBooks
Multicurrency Edition.

Company files with no foreign-currency transactions are not affected. If you
did not enable the Multicurrency feature in a company file (or if you enabled
Multicurrency, but did not create any foreign-currency transactions), you
should be able to upgrade that company file.

« If you work with a multicurrency file and you want to use QuickBooks
Multicurrency Edition, see quickbooks.ca/multicurrency

How can | tell whether my company file used the
Multicurrency feature?

To see if your company file has the multicurrency feature turned on:

1 Open your company file in your previous version of QuickBooks.

2 Go to the Edit menu and click Preferences.

3 Go to the list on the left of the window and click Accounting.

4 Click the Company Preferences tab.

5 Look in the Multicurrency area on the right of the window. If the Use
multicurrency checkbox is clear, you can upgrade this company file to
QuickBooks 2008.

If the checkbox is selected, then Multicurrency feature was turned on in your

company file. However, if none of your transactions used foreign currencies,

you may still be able to upgrade your company file. See the Does my
company file use Multicurrency? FAQ on the QuickBooks knowledgebase

(go to the QuickBooks Support knowledgebase at quickbooks.ca/support

and search for “does my company file use Multicurrency”). This article will

help you determine if you can upgrade to QuickBooks 2008.

Memorized reports

Memorized reports will not carry forward to
QuickBooks 2008. After you upgrade your
company file, recreate and memorize the
reports in QuickBooks 2008.

For more details, search
the in-product help for
“Memorizing a report
for reuse”.




Customized business forms

Form customization has been greatly improved.
Because of this, however, the form templates

have changed.

If you customized the way your business forms
print, review them after you upgrade your
company file. Some customization does not
carry forward into QuickBooks 2008, so you
may need to reformat your forms using the

Layout Designer.

The default forms included with QuickBooks do
not need to be changed. They will work with pre-
printed form paper from both QuickBooks 2008
and previous versions of QuickBooks.

For more details on
using the Layout
Designer, search the
in-product help for
“customize your forms”.

Accountant’s Copy

(QuickBooks Premier only) Accountant’s Copy
files created in earlier versions of QuickBooks
cannot be opened as an Accountant’s Copy

in QuickBooks 2008. You have two options for
working with Accountant’s Copy from

older versions:

QuickBooks.

Open the file in your previous version of

Convert the Accountant’s Copy to a regular
company file. You won't be able to work on the
company file at the same time as your client,
and he or she will not be able to import your
changes automatically.

For more details,
search the in-product
help for “convert
accountant’s copy”
and open the topic
named “Convert an
Accountant’s Copy to a
regular company file”.

Third-party applications

This version of QuickBooks 2008 is now compatible with thousands of
applications created for the US version of QuickBooks. You can find up-to-date
plug-in applications on the web at marketplace.intuit.com

However, third-party applications that were created for previous versions of
QuickBooks may not work with QuickBooks 2008. Contact the application’s

vendor for an upgraded version.




Getting around QuickBooks

The menu bar The customizable icon bar
provides easy access of the toolbar provides

to all QuickBooks one-click access to the

tasks, features and QuickBooks features that | —
reporting functions. you use most.

The navigation bar on
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Refer to the in-product
Help for detailed
instructions about how
to perform tasks in

QuickBooks.
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For further assistance, visit the QuickBooks support website
at quickbooks.ca/support

* For help with QuickBooks and technical issues, contact Product Support
at 1 877 772-9158 (Monday to Friday, 8:00 a.m. - 8:00 p.m., EST); fees
may apply.

« For help with orders, returns and exchanges, contact Customer Service at
1 888 333-8580 (Monday to Friday, 9:30 a.m. - 6:00 p.m., EST).
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